Microsoft Office Help
To see Help for your Office program, ask a question by using the
Office Assistant or the Ask a Question box on the program's menu
bar.

Install or remove individual components in Microsoft Office
If you originally installed your Microsoft Office program from a network file
server or from a shared folder, you must install or remove components
from that location. If you installed your Office program from a CD-ROM
and you've mapped your CD-ROM drive to a new drive letter since
installing the Office program, reinstall from the CD-ROM. If you're running
any Office program files from the CD-ROM, you must uninstall the Office
program and then reinstall it from the CD-ROM.
1. Quit all programs.
2. Double-click the Add/Remove Programs icon in the Windows
Control Panel.
3. Do one of the following:
For Windows 2000 and Windows Millennium Edition:
If you installed your Office program as part of Microsoft
Office, click Microsoft Office in the Currently installed
programs box, and then click the Change button.
If you installed your Office program individually, click the
name of your program in the Currently installed programs
box, and then click the Change button.
For Windows 98 and Windows NT 4.0:
If you installed your Office program as part of Microsoft
Office, click Microsoft Office on the Install/Uninstall tab,
and then click the Add/Remove button.
If you installed your Office program individually, click the
name of your program on the Install/Uninstall tab, and
then click the Add/Remove button.
4. Follow the instructions on the screen.
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About getting help while you work
If you need help while you work, you can use the following resources:
Ask a Question box
The Office Assistant
Help
ScreenTips
Help on the World Wide Web
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Use Help without the Office Assistant
1. To get Help without using the Office Assistant, the Assistant
must be turned off.
How?
2. On the Help menu, click Microsoft Program Name Help.
If the Contents, Answer Wizard, and Index tabs aren't visible,
click Show .
3. In the Help window, do the following:
Click the Contents tab to view the table of contents for Help.
Click the Answer Wizard tab to type a question about the
Microsoft Office program in which you are working. Type the
words you want to search for, and click Search.
Click the Index tab to search for specific words or phrases, or
choose from a list of keywords.
You can control the list of topics found by adding or removing
keywords from your search. In this way, you can narrow your
search until only the most relevant topics and keywords remain
in the list.
Note Not all languages support the Answer Wizard.
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Show or hide the Office Assistant in wizards
To turn on or off Office Assistant Help with wizards, do one of the
following:
Show or hide the Assistant for only one wizard
Show or hide the Assistant for all wizards
Note Not all wizards have Help provided by the Assistant.

Select a different Office Assistant
1. Click the Office Assistant.
If the Assistant isn't visible, click Show the Office Assistant on
the Help menu.
2. In the Assistant balloon, click Options.
If the Assistant balloon isn't visible, click the Assistant.
3. Click the Gallery tab, and then click Back or Next until you see
the Assistant you want.
Notes
If you have access to the Internet, you can download additional
Assistants from the Microsoft Office Web site. On the Help menu, click
Office on the Web.
The hyperlinks in this topic go to the Web. You can switch back to Help at
any time.
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Open the Office Readme file
The Microsoft Office XP Readme is an .htm file that contains latebreaking product news. It is located in different folders, depending upon
which language version you are using.
1. On the desktop, double-click My Computer.
2. Double-click the drive on which Microsoft Office is installed
(normally drive C).
3. Double-click Program Files.
4. Double-click Microsoft Office.
5. Double-click Office10.
6. Find the folder that contains your language's Readme file.
How?
7. Double click the folder that applies to your language.
For example, double-click 1033 for English.
8. Double-click Readme.htm.
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Guidelines for searching Help
Using complete sentences with the Office Assistant
Using the Answer Wizard
Using the Index to narrow your scope
Displaying programming and non-programming topics

About the Microsoft Office XP Developer's Guide
The Microsoft Office XP Developer's Guide teaches those who
understand the fundamentals of Microsoft Visual Basic how to create
concise, lean, and efficient code with the powerful programming
language used in Microsoft Office XP. The book teaches readers how to
become more productive with Visual Basic for Applications by
customizing and adapting tools for specific needs — including how to
create custom commands, menus, dialog boxes, messages, and buttons,
as well as how to show custom Help for all these elements.
You can obtain the Microsoft Office XP Developer's Guide wherever
computer books are sold. To locate your nearest source for Microsoft
Press products worldwide, visit the Microsoft Press Web site or contact
your local Microsoft office. In the United States, call (800) MS-PRESS. In
Canada, call (800) 667-1115.
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Get Help for Visual Basic for Applications
1. In order to do this procedure, programming Help must be
installed.
How?
2. On the Tools menu, point to Macro, and then click Visual Basic
Editor.
3. In the Office Assistant balloon, type the method, property,
function, statement, or object you want Help on, or type a query.
If the Office Assistant isn't visible, on the Help menu, click Show
Office Assistant.
If the Office Assistant balloon isn't visible, click the Assistant.
4. Click Search, and then click the topic you want.
Tips
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Display tips and messages through the Office Assistant
Do one or both of the following:
Customize how you want to use tips and messages
View a tip
Note Not all languages support all features of the Office Assistant.
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About Microsoft technical resources
If you have a question about a Microsoft Office program, first ask the
Office Assistant and then look in Discovering Microsoft Office XP or the
Readme file that comes with the program. If you don't find what you
need, you can get information from the technical resources in the
following list:
Microsoft Office Web site
Microsoft TechNet and Microsoft Developer Network CD-ROMs
Microsoft Knowledge Base
Microsoft Software Library
Microsoft Press

Turn the Office Assistant sound on or off
To hear sound from the Office Assistant, you must have a sound card
installed on your computer.
1. Click the Assistant.
If the Office Assistant isn't visible, click Show the Office
Assistant on the Help menu.
2. In the Office Assistant balloon, click Options.
If the Office Assistant balloon isn't visible, click the Assistant.
3. On the Options tab, select or clear the Make sounds check
box.

Show All

Print a Help topic
Do one of the following:
Print the current topic
Print a collection of topics

Get Help in Microsoft Script Editor
1. On the Tools menu, point to Macro, and then click Microsoft
Script Editor.
You will be prompted to install Microsoft Script Editor if you
haven't done so already. Click Yes.
2. In the Microsoft Script Editor, on the Help menu, click Microsoft
Script Editor Help, and do one or more of the following:
To view the table of contents, click the Contents tab.
To search for words, click the Answer Wizard tab. Type the
words you want to search for, and click Search.
To browse an index of keywords to find information, click the
Index tab. Select the keyword you want, and click Search.
Note Not all languages support the Answer Wizard.
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Change the appearance of a Help topic
1. Open the Help window.
How?
2. In the Help window, click Options
Options.

, and then click Internet

3. On the General tab, click Accessibility, and then click Ignore
colors specified on Web pages.
4. Click OK.
5. In the Internet Options dialog box, do one or both of the
following:
Change the color of the background or text in Help
Change the font in Help
Note If you change the font and background color of the Help topics in
the Help window, the change will also affect the font and background
color when you view a Web page in Microsoft Internet Explorer.
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About tips and messages from the Office Assistant
The Office Assistant can answer your questions, offer tips, and provide
help for a variety of features specific to the program you're using. The
Assistant is shared by all Microsoft Office programs. Any changes you
make to its options — such as the types of tips it displays — will affect
the Assistant in all of your Office programs.
The Assistant can display Help in the following ways:
Suggested Help
Help with wizards
Tips
Messages
Note Not all languages support all features of the Office Assistant.

Get ScreenTips about specific commands, buttons, and
dialog boxes
To see a ScreenTip for a menu command, toolbar button, or screen
region, click What's This? on the Help menu and then click the item you
want information about.
To see a ScreenTip for a dialog box option, click the question mark button
in the dialog box, and then click the option. (If you don't see the
question mark button, select the option and then press SHIFT+F1.)
To see the name of a toolbar button, rest the pointer over the button until
the name appears.

Get information about your program and computer
You can check which version of the Microsoft Office XP program is
installed on your computer, and you can determine the product ID
number of your copy of the program. You can also get system information
and perform a test of your network connection.
On the Help menu, click About Microsoft Program Name.

About the Office Resource Kit
The Microsoft Office XP Resource Kit is the definitive guide to installing,
configuring, and supporting Microsoft Office in your organization.
Designed for system administrators, consultants, and power users, this
guide offers complete coverage whether you're running Microsoft Office
on Microsoft Windows 98, Windows 2000, or the Macintosh.
You can obtain the Office Resource Kit wherever computer books are
sold or order direct from Microsoft Press, or online at the Microsoft Office
Resource Kit Web site.
To locate your nearest source for Microsoft Press products worldwide,
visit the Microsoft Press Web site or contact your local Microsoft office. In
the United States, call (800) MS-PRESS. In Canada, call (800) 667-1115.
Note The hyperlinks in this topic go to the Web. You can switch back to
Help at any time.
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Troubleshoot Help
A "Page Not Found" message appears in my browser when I click on a
Help topic
I can't access the Microsoft Office Web site.
The Office Assistant is distracting.
The Office Assistant doesn't show the Help topic I want.
The Office Assistant balloon disappeared.
The Office Assistant prevents me from working.
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About finding files
You can use the Search command in Microsoft Office XP to find files
wherever you work: on your computer hard drive, your local network,
your Microsoft Outlook mailbox, and your network places. You can also
find e-mail messages, meetings, and other information in your Outlook
mailbox. Search provides two methods of finding files: basic search and
advanced search.
Basic search is the most comprehensive way to search for files, Outlook
items, and Web pages. You can find files that contain specified text in the
title, contents, or properties. You can also specify where to look for files
and the types of files to search for.
Advanced search is more specific. You use it to find files based on their
properties. You do this by creating queries, which are sets of one or more
rules that must be true for a file to be found. An example of a query is
"author is (exactly) Dan." This specifies that the files you are searching
for should contain only the text "Dan" as the author property.
The Search task pane
Viewing search results
Speeding up search with fast searching
Building more complex searches using conditions and values
Searching from the Open dialog box
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Find a file
You can search the titles, contents, or properties of Microsoft Office files,
Microsoft Outlook items, and Web pages.
1. On the Standard toolbar, click Search

.

2. Do one of the following:
Search for a file or Outlook item containing specified text
Search for a file or Outlook item based on one or more
properties
In the Search Results task pane, you can take one or more actions on
the search results.
How?
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Find a file from the Open dialog box
1. Click Open

.

2. Click Tools in the Open dialog box, and then click Search.
3. Do one of the following:
Search for a file containing specified text
Search for a file based on one or more properties
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Advanced search conditions
Conditions are limitations you set on the value of a file property in an
advanced search to make it more specific. Each type of property, such as
text or date, has a set of relevant conditions that advanced search
displays automatically so that you can choose one to configure your
search. Here are the conditions that you can set for each type of
property, along with some example settings.
Conditions for text properties
Conditions for date properties
Conditions for file names
Conditions for numeric properties
Conditions for yes/no properties
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Administer fast searching
Fast searching extracts information from files and organizes it in a way
that makes the files quicker and easier to find through Search.
Enable or disable fast searching
Specify which folders to index
Update the index
Delete the index
View the status of the index
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Troubleshoot searching
It takes a long time to search for files.
I can't save a search query.
I know a file is on a drive or Web folder, but Office Search doesn't find
it.
The wrong files appear after I do a search.
I can't search some of my Web folders.
I can't search my mailbox.
I can't search for a specific file type.
I am having trouble using natural language search.
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About file properties
Document properties are details about a file that help identify it — for
example, a descriptive title, the author name, the subject, and keywords
that identify topics or other important information in the file. Use
document properties to display information about a file or to help
organize your files so that you can find them easily later. You can also
search for documents based on document properties.
Types of document properties
Setting document properties
Viewing document properties
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Change file properties
You can change document properties from the currently open document
or from the list in the Open dialog box:
From the current document
From the Open dialog box

Create custom file properties for the active document
1. On the File menu, click Properties.
2. Click the Custom tab.
3. In the Name box, type a name for the custom property, or select
a name from the list.
4. In the Type box, click the data type for the property you want to
add.
5. In the Value box, type a value for the property. The value you
enter must match the selection in the Type box. For example, if
you click Number in the Type box, you must type a number in
the Value box. Values that don't match the property type are
stored as text.
6. Click Add.
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View file properties
You can view document properties from the currently open document or
from the file list in the Open dialog box:
From the current document
From the Open dialog box
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About team Web sites
Team Web sites are Web sites with added features to enable a group to
share files, participate in discussions, and communicate all kinds of
information. There are two kinds of team Web sites that you can work
with from your Office programs.
Microsoft's SharePoint Team Services
Microsoft SharePoint Portal Server
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About document libraries
Document libraries are collections of files that are shared in SharePoint
team Web sites. For example, you could create a library of common
graphics for a project or a collection of Microsoft Word documents
containing your monthly status reports.
You can view document libraries from a Web browser, such as Internet
Explorer, or as a Network Place from Office XP programs, or the
Windows desktop.
When you add or remove a file from a document library, the server
updates the navigation links to it on the Web page. This ensures that
anyone viewing the Web site can find the documents there. Team Web
site members can subscribe to a document library so they are notified by
e-mail when a member adds or changes a file.
When you create a document library, you can specify the information
authors must provide when they add a file to the library. For example, if
you have a document library of product plans, you can require authors to
enter the title, comments about the content, and the document's status
(such as preliminary or approved). This information appears when you
view the document library listing.
Once in a library, you can open and modify your documents from within
Office XP programs just as though they resided on any other network
place or local drive.
To ensure that all documents within the library have a consistent look and
feel, you can also specify a template to be used when a new file is added
to the library. You can modify this template by using Office XP programs
just as you would any other template.
Notes
You can also add a document library to any Microsoft FrontPage Web
site hosted by a server running SharePoint Team Services from
Microsoft.
You can use Microsoft Outlook to view document libraries hosted by a
server running Microsoft Exchange Server 2000.
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About templates for document libraries
In document libraries, you can give all the shared files a consistent look
and feel. You ensure this consistency by specifying a template for the
document library files. For example, if you have a library of presentations,
you can specify a PowerPoint file as a template. When a team Web site
member creates a new presentation in the library, PowerPoint starts and
then opens the presentation template. The team member can then add
content to the slides without having to worry about the overall look and
feel of the presentation.
After creating the new content, the team member saves the file to the
document library under a new name. The server then adds a link to the
new file in the team Web site navigation. Any team members viewing the
site will see the new file.
Although the library files will be located on a Web server, the template file
doesn't need to be in HTML (.htm) format. It's best to choose the format
based on the type of files that you'll be sharing in the library. For
example, if you're sharing a library of Microsoft Word files, your template
file should be in .dot format. You can create, save, or modify the template
from your Office XP program.
Note You can have only one template file per library.
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Create a team Web site
Before you can create a team Web site, you should ask your system
administrator or Internet service provider (ISP) for the URL of a Web
server running SharePoint Team Services from Microsoft.
1. Create a new network place.
Windows 2000 or Windows Millennium Edition
Windows NT 4.0 or Windows 98
2. Type the URL of the server that will host your team Web site.
3. Type a name for the shortcut to the team Web site, and then
click Next.
4. Follow the instructions in the wizard to set up your team Web
site.
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Change the properties of a file in a document library
1. Open the Microsoft Office XP program that was used to create
the file for which you want to change properties.
2. Click File, and then click Open.
3. To open your list of shortcuts to Web servers, do one of the
following:
In Windows 2000 or Windows Millennium Edition, click My
Network Places.
In Windows NT 4.0 or Windows 98, click Web Folders.
4. If you have already created a shortcut to the team Web site with
the document library that contains the file you want to change,
double-click it.
If you have not created a shortcut to the team Web site, you
must create a shortcut.
How?
5. Double-click the document library that contains the file whose
properties you want to change.
6. Double-click the file.
7. Click File, and then click Properties.
8. For each property you would like to change, click the Property
box, and then type the new text.
Tips
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Open a file in a document library
1. Open the Microsoft Office program that was used to create the
file.
2. Click File, and then click Open.
3. To open your list of shortcuts to Web servers, do one of the
following:
In Windows 2000 or Windows Millennium Edition, click My
Network Places.
In Windows NT 4.0 or Windows 98, click Web Folders.
4. If you have already created a shortcut to the document library
with the file you want to open, double-click it.
If you haven't created a shortcut to the document library that
contains the file you want to open, you must create a shortcut.
How?
5. Double-click the document library that contains the file you want
to open.
6. Double-click the file.

Show All

Save a file to a document library
1. In any Microsoft Office XP program, click File, and then click
Save As.
2. To open your list of shortcuts to Web servers, do one of the
following:
In Windows 2000 or Windows Millennium Edition, click My
Network Places.
In Windows NT 4.0 or Windows 98, click Web Folders.
3. If you have already created a shortcut to the document library,
double-click it.
If you haven't created a shortcut to the document library, you
must create a shortcut.
How?
4. Double-click the document library where you would like to save
the file.
5. In the File name box, type a name for the file (or keep the
current file name), and then click Save.
6. Depending on how the document library is set up, you may be
prompted to enter information about the document. Type the
requested information in the fields provided, and then click OK.
Tip
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Delete a file in a document library
1. In any Office XP program, click File, and then click Open.
2. To open your list of shortcuts to Web servers, do one of the
following:
In Windows 2000 or Windows Millennium Edition, click My
Network Places.
In Windows NT 4.0 or Windows 98, click Web Folders.
3. If you have already created a shortcut to the team Web site with
the document library with the file you want to delete, doubleclick it.
If you haven't created a shortcut to the team Web site, you must
create a shortcut.
How?
4. Double-click the document library that contains the file you want
to delete.
5. Click the file you want to delete, and then click Delete
Tip

.
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Use a template to create a file for a document library
1. Open the Microsoft Office XP program that you want to use to
create the file.
2. From the New File task pane, click Templates on my Web
sites.
If the New File task pane is closed, click File, and then click
New.
3. If you've created a shortcut to the team Web site where you
want to create the file, double-click it.
If you haven't created a shortcut to the team Web site, you must
create a shortcut.
How?
4. Double-click the template file for that document library.
5. Type the content for the new file.
6. Click File, and then click Save.
7. Type a name for the file, and then click Save.
8. Depending on how the document library is set up, you may be
prompted to enter information about the document. Type the
requested information in the boxes provided, and then click OK.
Tip
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About working with files on Web servers and network
servers
You can create, copy, save, or manage folders and files that reside on
network, Web, or FTP servers. Once you create shortcuts to these
folders, you can work with the files in them just as though they were on
your local computer. You can access these folders from:
The Open and Save dialog boxes in Office programs.
My Network Places (Windows 2000 and Windows Millennium Edition).
Network Neighborhood and Web Folders (Windows NT 4.0 and Windows
98).
To find a network, FTP, or Web server that you can connect to, see your
system administrator or Internet service provider.
Requirements for creating a shortcut to a folder on a network file server
Requirements for creating a shortcut to a folder on a Web or FTP server

Where to create a shortcut to a folder on a Web server or
network server
Both Windows and Office provide wizards for setting up shortcuts to
folders on Web servers and network servers. However, the Office Add
Network Place wizard is used for setting up shortcuts to folders on Web
or FTP servers only. Therefore, if you want to:
Create a shortcut to a folder on a Web or FTP server from an Office
program
Create a shortcut to a folder on your local area network
Create a shortcut to a folder on a Web or FTP server from Windows

Web server features available through shortcuts
Creating shortcuts to Web servers can get you access to many services
ranging from simple storage space to easy-to-create custom Web sites.
For example, SharePoint team Web sites, based on SharePoint Team
Services from Microsoft, let you share libraries of files, discuss important
issues online, and manage tasks for the whole team.
Some Internet service providers offer additional functionality and even
customize the appearance of the shortcut. These Web sites have a wide
variety of features for both office and home users. For example, home
users will find that these sites are a great way to set up a photo gallery to
share pictures with family and friends. The features that each ISP
provides for these Web sites vary. A list of ISPs that provide these
services is provided in the Office Tools on the Web catalog, available
from the Add Network Place Wizard.
The shortcut indicates the type of folder that it points to:
Shortcut to a Web or FTP server, or a SharePoint team Web site.
Shortcut to a Web site hosted by MSN. Other ISPs may have
custom icons for shortcuts to sites they host.
Shortcut to a document library.
Shortcut to a shared folder on a network file server.
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Create a shortcut to a folder on a Web server
Before you can create a shortcut to folder on a Web server, you should
ask your system administrator or Internet service provider (ISP) for the
URL of a Web site you can save files to.
Windows 2000 and Windows Millennium Edition
Windows NT 4.0 and Windows 98
Note The Office Add Network Place Wizard is used for setting up
shortcuts to folders on Web and FTP servers only. To create a shortcut to
a folder on a network file server:
In Windows 2000 and Windows Millennium Edition, use the Add Network
Place Wizard in My Network Places.
In Windows NT 4.0 and Windows 98, use My Network Neighborhood.

Show All

Open a file on a Web server
1. In any Office program, click File, then click Open.
2. To open your list of shortcuts to Web servers, do one of the
following:
In Windows 2000 or Windows Millennium Edition, click My
Network Places.
In Windows NT 4.0 or Windows 98, click Web Folders.
3. Double-click the network place for the Web server that contains
the file you want to open.
If you don't see a network place for that Web server, you must
create a new network place.
How?
4. Double-click the folder that contains the file you want to open,
and then double-click the file.
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Create a file from a template on a Web server
1. Open the Office program you want to use to create the file.
2. From the New File task pane in any Office XP program, click
Templates on my Web sites.
If the New File task pane is closed, click File, and then click
New.
3. If you have created a shortcut to the folder on the Web server
that contains the template you want to use, double-click the
shortcut.
If you haven't created a shortcut to the folder on the Web server
that contains the template you want to use, you must create a
new shortcut.
How?
4. Double-click the folder that contains the template you want to
use.
5. Double-click the template file.
6. Type the content for the new file.
7. Click File, and then click Save.
8. Type a name for the file, and then click Save.
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Create a Web site
Microsoft Office provides you with two ways to create a Web site without
using any HTML coding. You can create a SharePoint team Web site,
based on SharePoint Team Services from Microsoft, or you can create a
Web site through an Internet service provider (ISP) listed on the Office
Tools on the Web catalog.
Create a team Web site
""
Create a Web site hosted by a provider listed in Office Tools on the
Web
Tip
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Save a file to a Web server
1. In any Office program, click File, and then click Save As.
2. To open your list of shortcuts to Web servers, do one of the
following:
In Windows 2000 or Windows Millennium Edition, click My
Network Places.
In Windows NT 4.0 or Windows 98, click Web Folders.
3. If you have already created a shortcut to the folder on the Web
server with the file you want to open, double-click it.
If you haven't created a shortcut to the Web server, you must
create a shortcut.
How?
4. In the File name box, type a name for the file (or keep the
current name).
5. Double-click the folder where you would like to save the file, and
then click Save.
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About managing Web files and links
When you create Web pages, your Microsoft Office application manages
the related files and inserts the links and hyperlinks so that the images
appear and the links work when the pages are placed on the Web server.
Managing links
Managing and naming supporting files
Testing links
Tip
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About working with graphics on Web pages

Graphic formats in Web pages
The first time you save your file in HTML format, all graphics are
converted to .gif, .jpg, or .png format, all of which are image types
supported on the World Wide Web. You can use graphics that are
provided with Microsoft Office, such as clip art, AutoShapes, text boxes,
and WordArt, or create your own graphics in .gif format. If you have
Internet access, you can get more graphics from the Microsoft Web Art
Resources Web page. When you reopen the Web page in your Office
application, you can edit all graphics as you normally would.

Inserting graphics from a file
When you insert a graphic from a file, you can either insert the entire
graphic or you can insert a link to the graphic at a fixed location, such as
another Web server, or at a relative file location. Linking a graphic to your
Web page reduces the size of the page, makes it easier to update the
graphic, and makes it easier to share the graphic between different Web
pages. In Windows, if you move or copy a Web page to another location,
you should make sure that you also move or copy any supporting files —
such as graphics, background textures, and bullets — so that you
maintain the graphic links to your Web page.
Tip

Using art from Office application drawing tools
You can use AutoShapes, text boxes, and WordArt effects in the files that
you save to HTML from your Office applications. After you save your file
to HTML format, you can open and view it in a Web browser, or you can
open and edit it in any Office application. From your Office application,
you can open and edit all drawings that you have saved to HTML format
from any other Office application.

Using animated .gif images
You can insert animated .gif images into Office application files. When
you save an animated .gif image in HTML format, the animation is
preserved. You cannot perform certain editing operations — such as
cropping, grouping, or changing the fill, border, or shadow — on an
animated .gif image. Make these changes in a program that supports
animated .gif editing, and then insert the animated .gif image in the file.

Aligning graphics
The Drawing and Picture toolbars in Office applications provide
alignment commands that help you arrange your graphics. Selecting a
picture automatically displays the Picture toolbar. To hide the Picture
toolbar, right-click a picture, and then click Hide Picture Toolbar on the
shortcut menu.

About Portable Network Graphics (.png) format
Portable Network Graphics (.png) is a graphic file format supported by
many Web browsers. It is a good format for compressing and storing
graphic images, and there is no loss of graphic image data when an
image is uncompressed. The .png format supports variable transparency
of images (alpha channels) and control of image brightness on different
computers (gamma correction). It is used for a wide range of graphics
from small images (such as bullets and banners) to complex images
(such as photographs).
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About Web archives (MHTML)
A Web archive saves all the elements of a Web site, including text and
graphics, into a single file. This encapsulation lets you publish your whole
Web site as a single MIME encapsulated aggregate HTML document
(MHTML) file or send an entire Web site as an e-mail message or
attachment. This format is supported by Internet Explorer 4.0 and later.
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Language-specific names for Web page supporting folders
By default, when you save your file as a Web page, all supporting files —
such as bullets, background textures, and graphics — are organized in a
supporting folder. The name of the supporting folder is the name of the
Web page plus an underscore (_), a period (.), or a hyphen (-), and the
word "files." The word "files" will appear in the language of the version of
Microsoft Office that was used to save the file as a Web page. For
example, suppose you use the Dutch language version of Office to save
a file named Page1 as a Web page. The default name of the supporting
folder would be Page1_bestanden.
Note If you save your Web page with a short file name (maximum of
eight characters, plus a three-character file extension) by clearing the
Use long file names whenever possible check box in the Web
Options dialog box, the supporting folder is the name of the Web page
without the word "files."
The default name for the Web page supporting folder in each language
version of Office

Save graphics in .png format
1. On the Tools menu, click Options.
2. Click the General tab, and then click Web Options.
3. Click the Browsers tab.
4. Under Options, select the Allow PNG as a graphics format
check box.
Note Before you save your file in .png format, check with your system
administrator to find out whether your Web browser supports .png format.

Speed up downloading Web pages by using Vector Markup
Language
1. On the Tools menu, click Options.
2. Click the General tab, and then click Web Options.
3. Click the Browsers tab.
4. Under Options, select the Rely on VML for displaying
graphics in browsers check box.
Notes
If you turn on this advanced Web option, and you view a Web page in a
browser that does not recognize graphics in VML format (such as
Microsoft Internet Explorer 4.0 or earlier), you will not see any graphics.
Even though your graphics don't appear in a Web browser, you can
always open your Web page in your Office application to edit the
graphics.
Before you send a file in HTML format as an e-mail message with the
Web option Rely on VML for displaying graphics in browsers turned
on, make sure that the recipient of your message can view the file in an
e-mail system that recognizes graphics in VML format (such as Microsoft
Outlook 2000 or later). Otherwise, recipients won't see any graphics in
the e-mail message.

Optimize Web pages for a specific browser
1. On the Tools menu, click Options.
2. On the General tab, click Web Options.
3. On the Browsers tab, in the People who view this Web page
will be using list, select the appropriate browser version.
4. In the Options list, select or clear the check box for any features
you want to enable or disable.
Note When you choose a setting from the People who view this Web
page will be using list, the default features for the selected browser
version are set in the Options list.
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Troubleshoot Web page options

Working with files and links
I don't want to keep my supporting files in a folder
""
I saved my Web page to a file server, and now some people can't find
or view it
""
I moved my Web page to another location and now some of the links
are broken
""
I can't automatically create a backup copy of my Web page
""
The name of a supporting folder for a Web page is in another language
""
The HTML file I want to edit opens in the wrong Office application
My Web page has the wrong title
""

Working with graphics
I see a red X, a blank image, or no image at all on my Web page
""
The graphics and text on my Web page look different on another
computer
""

Specifying the language and fonts
My Web page is displaying the wrong characters for a language
""

Working with different Web browsers
My Web page doesn't look right in my Web browser
""

Use the Office Shortcut Bar
You can use the Microsoft Office Shortcut Bar for single-click access to
the resources you use most often. You can quickly start a new file, open
an existing file, or start an Office program.
On the Microsoft Windows Start menu, point to Programs, point to
Microsoft Office Tools, and then click Microsoft Office Shortcut Bar.
Note For Help using the Office Shortcut Bar, click the Office Shortcut
Bar menu , and then click Help.

Close the Office Shortcut Bar
1. Click the Office Shortcut Bar button
2. Click Exit.

.
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Move the Office Shortcut Bar
1. If the Microsoft Office Shortcut Bar is minimized, click the Office
Shortcut Bar button on the Windows taskbar.
2. Drag the title bar or the background of any toolbar on the Office
Shortcut Bar where you want it, either docked to one edge of
your screen or floating on the desktop.
Note When you dock the Office Shortcut Bar along an edge of your
screen, your desktop is adjusted so that the Office Shortcut Bar doesn't
cover anything.
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Hide the Office Shortcut Bar
Click the Office Shortcut Bar button

, and then click Auto Hide.

Notes
To use the Microsoft Office Shortcut Bar when it's hidden, point to the
edge of the screen where the Office Shortcut Bar is docked, and it will
reappear temporarily.
The Auto Hide command on the Office Shortcut Bar menu
and the
Auto Hide between uses check box on the Customize dialog box
(Office Shortcut Bar menu ) have no effect when the Office Shortcut
Bar is minimized or floating, or when the Auto fit into title bar area
check box is selected and the Office Shortcut Bar is docked at the top of
the screen.
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Start a new file
1. On the Office toolbar, click New Office Document

.

2. Click the tab for the type of document you want to create.
3. Double-click the template or wizard you want to base your
document on.

Open a file
1. On the Office toolbar, click Open Office Document

.

2. Locate the document you want to open, and then double-click
the name of the document.

Open a different toolbar
If the toolbar you want is not visible, right-click the background of any
toolbar on the Microsoft Office Shortcut Bar, and then click the name of
the toolbar on the shortcut menu to display it.
If the toolbar you want is visible but not active, click the icon with the
toolbar name to display it.
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Add a button
1. Right-click the background of any toolbar on the Microsoft Office
Shortcut Bar, and then click Customize on the shortcut menu.
2. Click the Toolbars tab.
3. Make sure the check box next to the toolbar you want to add the
button to is selected.
4. Click the Buttons tab.
5. In the Toolbar box, click the name of the toolbar you want to
add a button to.
6. To add a button for a file or a folder, click Add File or Add
Folder.
Tip

Rename a button
1. Right-click the toolbar button that you want to rename, and then
click Rename on the shortcut menu.
2. In the New Name box, type the new name for the toolbar button.

Move a button
Hold down ALT and drag the toolbar button to a new location on the
same toolbar or on a different toolbar.
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Show or hide a button
1. Right-click the background of any toolbar on the Microsoft Office
Shortcut Bar, and then click Customize on the shortcut menu.
2. Click the Toolbars tab.
3. Make sure the check box next to the toolbar containing the
button is selected.
4. Click the Buttons tab.
5. In the Toolbar box, click the name of the toolbar that contains
the button you want to show or hide.
6. To show or hide a toolbar button, select or clear the check box
next to the button you want in the Show these files as buttons
box.
Tip

Delete a button
1. Right-click the background of any toolbar on the Microsoft Office
Shortcut Bar, and then click Customize on the shortcut menu.
2. Click the Buttons tab.
3. In the Toolbar box, click the name of the toolbar that contains
the button you want to delete.
4. In the Show these files as buttons box, click the button you
want to delete, and then click Delete.
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Add or remove a toolbar
When you remove a toolbar from the Microsoft Office Shortcut Bar, it is
deleted from the Toolbar box in the Customize dialog box (Office
Shortcut Bar menu ), but all the folders, files, and shortcuts within the
toolbar folder are not deleted from your hard disk. If you think you'll need
the toolbar again, hide it rather than remove it.
When you hide a toolbar, the toolbar doesn't appear on the Office
Shortcut Bar, but it still appears in the Toolbar box, so you can display
the hidden toolbar again when you want to use it.
Add a toolbar
Remove a toolbar
Show or hide a toolbar

Rename a toolbar
1. Right-click the background of any toolbar on the Microsoft Office
Shortcut Bar, and then click Customize on the shortcut menu.
2. Click the Toolbars tab.
3. Click the toolbar you want to rename, and then click Rename.
4. In the New Name box, type the new name for the toolbar.

Change the appearance of the Office Shortcut Bar
1. Right-click the background of any toolbar on the Microsoft Office
Shortcut Bar, and then click Customize on the shortcut menu.
2. On the View tab, select the options you want.
Note The Change Color button affects only the toolbar that appears in
the Toolbar box.
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About multilingual features in Office
Microsoft Office XP programs support editing and viewing of documents
in more than 80 languages by taking advantage of the Unicode text
encoding standard. The many different multilingual features of Office are
helpful if you work with files that contain text in more than one language,
if you work in a multinational organization, or if you share files with
people who use Office on systems that run in other languages.
You or your system administrator can customize Office to handle
conventions and requirements that are unique to each language. You can
also add language-specific commands and features to Office.
Multilingual features
Unicode support in Office
Setting up your computer and keyboard to work in more than one
language
Setting up your Office program to work in more than one language
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About Microsoft Office XP Proofing Tools
Microsoft Office XP Proofing Tools is an add-in package that contains the
proofing tools that Microsoft makes for over 30 languages — for example
fonts, spelling and grammar checkers, AutoCorrect lists, AutoSummarize
rules (Microsoft Word only), translation dictionaries, and, for Asian
languages, Input Method Editors (IMEs).
Microsoft Office XP Proofing Tools is available at Shop.microsoft.com, or
outside the United States from a licensed reseller.
For more information about Proofing Tools, see the Microsoft Office Web
site.
Note The hyperlinks in this topic go to the Web. You can switch back to
Help at any time.
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About the global interface and Microsoft Office XP
Multilingual User Interface Pack
Microsoft Office XP Multilingual User Interface Pack adds key multilingual
capabilities to those already built into Microsoft Office by providing the
translated text for the user interface, Help, wizards, and templates for
Office programs. By using Office XP MUI Pack, you're working in the
English version of Office, but you can view commands, dialog box
options, Help topics, wizards, and templates in a familiar language.
Office XP MUI Pack also includes Microsoft Office XP Proofing Tools,
which provides fonts, spelling and grammar checkers, AutoCorrect lists,
and other tools that can help you create and edit Office files in the
language of your choice.
When you change the language of the user interface or Help, you change
it for all Office programs. Changing the language of the user interface
does not change the file format of Office files that you save, nor does it
change the program in any other way. You don't need a converter to open
files. Some components of Office do not support changing the language
of the user interface or Help.
Office XP MUI Pack works with Office running on Microsoft Windows 98
or later and Microsoft Windows NT version 4.0 or later. Microsoft
Windows 2000 provides the most support for the most languages, and it
is recommended for extensive multilingual use.
Office XP MUI Pack is on its own CD and has its own installer. To obtain
Office XP MUI Pack, see your system administrator.
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Requirements for specific languages
Operating system requirements vary depending on the language you're
working with.
East Asian languages (Simplified Chinese, Traditional Chinese,
Japanese, and Korean)
South Asian languages (Thai, Hindi, and Vietnamese)
Baltic, Central European, Greek, Turkish, and languages that use the
Cyrillic alphabet
Right-to-left languages

Languages supported by the Answer Wizard
The following languages have Answer Wizard support; that is, you can
find Help topics by asking questions in your own words either via the
Office Assistant or on the Answer Wizard tab in Help.
Arabic
Chinese (Simplified)
Chinese (Traditional)
Czech
Danish
Dutch
English
Finnish
French
German
Hebrew
Italian
Japanese
Korean
Norwegian
Polish
Portuguese (Brazil)
Portuguese (Portugal)
Russian
Spanish
Swedish

Thai (limited support)

Locale identification numbers for language-specific files
The following table lists the languages supported by Microsoft Office and
their corresponding LCIDs.
Language
Afrikaans

LCID
1078

Albanian
Amharic
Arabic
Armenian
Assamese
Azeri (Cyrillic)
Azeri (Latin)
Basque
Belarusian
Bengali
Bulgarian
Catalan
Cherokee
Chinese (Simplified)
Chinese (Traditional)
Croatian
Czech
Danish
Dhivehi
Dutch
Edo
English (Australian)
English (Canadian)
English (U.K.)

1052
1118
1025
1067
1101
2092
1068
1069
1059
1093
1026
1027
1116
2052
1028
1050
1029
1030
1125
1043
1126
3081
4105
2057

English (U.S.)

1033

Estonian
Faeroese
Farsi
Filipino

1061
1080
1065
1124

Finnish
French
French (Canadian)
Frisian
Fulfulde
Galician
Georgian
German
German (Austrian)
German (Swiss)
Greek
Gujarati
Hausa
Hawaiian
Hebrew
Hindi
Hungarian
Ibibio
Icelandic
Igbo
Indonesian
Inuktitut
Italian
Japanese
Kannada

1035
1036
3084
1122
1127
1110
1079
1031
3079
2055
1032
1095
1128
1141
1037
1081
1038
1129
1039
1136
1057
1117
1040
1041
1099

Kanuri

1137

Kashmiri
Kashmiri (Arabic)
Kazakh
Kyrgyz

2144
1120
1087
1088

Konkani
Korean
Latin
Latvian
Lithuanian
FYRO Macedonian
Malay
Malayalam
Maltese
Manipuri
Marathi
Mongolian
Nepali
Norwegian Bokmal
Norwegian Nynorsk
Oriya
Oromo
Pashto
Polish
Portuguese (Brazil)
Portuguese (Portugal)
Punjabi
Romanian
Russian
Sanskrit

1111
1042
1142
1062
1063
1071
1086
1100
1082
1112
1102
1104
1121
1044
2068
1096
1138
1123
1045
1046
2070
1094
1048
1049
1103

Serbian (Cyrillic)

3098

Serbian (Latin)
Sindhi
Sinhalese

2074
1113
1115

Slovak
Slovenian
Somali

1051
1060
1143

Spanish
Swahili
Swedish
Syriac
Tajik
Tamazight (Berber/Arabic)
Tamazight (Latin)
Tamil
Tatar
Telugu
Thai
Tigrigna (Ethiopia)
Tigrigna (Eritrea)
Turkish
Turkmen
Ukrainian
Urdu
Uzbek (Cyrillic)
Uzbek (Latin)
Vietnamese
Yi
Yiddish

3082
1089
1053
1114
1064
1119
2143
1097
1092
1098
1054
1139
2163
1055
1090
1058
1056
2115
1091
1066
1144
1085

Yoruba

1130
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Install system support for multiple languages
Do one of the following to install multilingual support for:
Windows 2000
Windows 98 or Windows Millennium Edition
Windows NT 4.0
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Install the universal font for Unicode
Arial Unicode MS font is a full Unicode font. It contains all of the
characters, ideographs, and symbols defined in the Unicode 2.1
standard.
In Microsoft Windows 2000 or Windows Millennium Edition
In Microsoft Windows 98 or Windows NT 4.0
Note Because of its considerable size and the typographic
compromises required to make such a font, Arial Unicode MS should be
used only when you can't use multiple fonts tuned for different writing
systems. For example, if you have multilingual data from many different
writing systems in Microsoft Access, you can use Arial Unicode MS as
the font to display the data tables, because Access can't accept many
different fonts.
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Use a keyboard layout for a specific language
You can use specialized keyboard layouts to type in specific languages. If
you have more than one keyboard layout installed, you can switch
between them.
Install keyboard layouts for specific languages
Switch keyboard layouts
Note To type East Asian text, you must be using an Input Method Editor
(IME).

Change the default country/region
Changing the default country/region changes the standard settings for
numbers, currencies, time, and date to those most commonly used for
that country/region.
1. On the Microsoft Windows Start menu, point to Settings, and
then click Control Panel.
2. Double-click the Regional Options or Regional Settings icon.
3. In the Your locale (location) list, select the country/region you
want to use as the default.
If you are using Microsoft Windows 2000 and don't see the item
you want, first select the check box next to the appropriate
language in the Language settings for the system box.
4. Click OK, and then restart your program.
Note When you change the country/region in the Your locale (location)
list, settings, such as the format for displaying currency and date, may
also change. Check all the tabs in the Regional Options dialog box to
make sure they are correct.
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Remove commands and controls for languages you don't
use
If there are languages that you no longer work with in your Microsoft
Office program, you can simplify the appearance of your user interface
and save memory by turning off editing for the languages, and deleting
the fonts that you aren't using.
Turn off editing for languages you don't want
Remove fonts you don't use
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Use Visual Keyboard to work with different keyboard
layouts
If you change your keyboard layout to that of a different language, the
characters that appear on the screen when you type may no longer
correspond to the characters printed on your keyboard. Microsoft Visual
Keyboard is an on-screen keyboard layout program that displays the
keyboard layout corresponding to the language your keyboard is set to.
You can also use Visual Keyboard to enter text.
1. Install Visual Keyboard.
How?
2. Start Visual Keyboard.
How?
3. Switch to the keyboard layout you want to use.
How?
The keyboard on the screen will change to reflect the keyboard
layout you're using.
For more information, such as how to type text by using Visual Keyboard,
see Visual Keyboard Help. On the Help menu, click Microsoft Visual
Keyboard Help.
Note The hyperlink in this topic goes to the Web. You can switch back
to Help at any time.
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About Input Method Editors (IMEs)
An Input Method Editor (IME) is a program that allows you to enter Asian
text in programs by converting your keystrokes into Asian characters.
The IME interprets your keystrokes as characters, then gives you the
opportunity to insert the correct interpretation into the program you're
working in.
The Simplified Chinese, Traditional Chinese, Japanese, and Korean
language versions of Microsoft Office each come with the IMEs for that
language. If you are using a different language version of Microsoft
Office, you can download the IME you want from the Microsoft Office
Web site. IMEs are also available in the Microsoft Office XP Proofing
Tools.
Once you have installed the IME, you can access it from the Language
bar that appears by default in the upper-right corner of the screen in any
Office program.
Notes
If you used what was referred to as a Global IME with a previous version
of Office, it will not work with Microsoft Office XP. You need to download
the updated version from the Web.
The hyperlink in this topic goes to the Web. You can switch back to Help
at any time.
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Install an Input Method Editor (IME)
The Simplified Chinese, Traditional Chinese, Japanese, and Korean
language versions of Microsoft Office each come with the IMEs for that
language. If you are using a different language version of Microsoft
Office, you can download the IME you want from the Microsoft Office
Web site.
Go to the Microsoft Office Web site, navigate to the IME download page
you want, and then follow the instructions there.
Once you have installed the IME, you can access it from the Language
bar that appears on the screen. For detailed information about using the
IME, see the Help that is included with it.
IMEs are also included with the Microsoft Office XP Proofing Tools. For
more information about Proofing Tools, visit the Microsoft Office Web site.
Notes
The hyperlinks in this topic go to the Web. You can switch back to Help at
any time.
If you used what was referred to as a Global IME with a previous version
of Office, it will not work with Office XP. You need to go to the Web site
listed above to download an updated version.

